
EXERCISE 7: ANALYZE TOPOGRAPHY 
In this exercise, you will work with ArcGIS Spatial Analyst surface analysis tools. Step 1 
through Step 6 deal with hillshades and contours. Step 7 and Step 8 present surface 
analysis with slope, aspect, curvature, and viewshed analysis. 
 
 
STEP 1: CREATE A HILLSHADE 
Shaded relief maps are perhaps the most attractive raster cartographic product. The 
shading effect gives maps depth, making it easy to visualize the terrain under the data. In 
this step, you will create a hillshade from an elevation surface and display another layer 
over it. 
 
 

□ Start ArcMap with A new empty map. 
□ Add the following layers to the map from your Exercise11 folder: 

o Elevation.lyr 
o LandWater.lyr 

□ Turn off Land Water. 
□ Turn on Elevation, expand its legend, and move it to the bottom of the Table of 

Contents. 
 

This is the Emerald Bay quadrangle in the Lake Tahoe database. The grayscale Elevation 
layer does not provide much topographical information. You can tell that there are 
mountains on the left side of the map and low places elsewhere. But for the most part, the 
details of the surface are hidden. Now set the analysis environments. 
 

□ Set these Environment Settings: 
□ Current Workspace: ... \Exercise11 
□ Scratch Workspace: ... \Exercise11 
□ Output Coordinate System: Same as Layer ‘Elevation” 
□ Cell Size: Same as Layer ‘Elevation” 
□ Mask: <none> 

 
Now you will create a hillshade for comparison. You can use the Hillshade dialog in the 
ArcGIS Spatial Analyst user interface for this task, you can 
use the Map Algebra HIILLSHADE function in the Raster 
Calculator, or you can use the ArcToolbox tools.  This time 
you will use the Hillshade surface tool from ArcToolbox. 
 
 

□ Open the ArcToolbox window 
□ Run ... > Surface > Hillshade: 
□ Input raster: select Elevation 
□ Output raster: type hillshade 
□ Accept the defaults for the remaining parameters. 
 



As you see, it is much easier to identify mountains and valleys from a hillshade than it is 
from a raw elevation surface. 
 
The two most important settings in Hillshade are the Azimuth and Altitude. These control 
the position of the ‘sun’ used to illuminate the surface. The azimuth is the compass 
direction toward the sun, while the altitude is the elevation of the sun above the horizon. 
Changing the azimuth exposes different cells, while changing the altitude makes shadows 
longer or shorter. The first example (above) places the sun at 315 degrees azimuth 
(northwest) and 45 degrees altitude (halfway up the sky). 
 
You should always place the sun in the northwest quadrant of your map for mapping 
applications (i.e., somewhere between 270 and 360 degrees). This is because people 
expect to see shadows on the bottoms of things. If you put the sun where it really 
belongs, most people will perceive the mountains as being valleys. To illustrate this, 
create another hillshade with the sun in the southeast. 
 
 

□ Turn off hillshade and collapse its legend. 
 
□ Run .. > Surface > Hillshade: 

 
□ Input raster: select Elevation 

 
□ Output raster: type hillshade2 

 
□ Azimuth: type 135 

 
□ Accept the defaults for the remaining parameters 

 
 
In this graphic, most people will see Lake Tahoe as a plateau and the mountains around it 
as canyons and valleys. The United States Geological Survey (USGS) suggests that 
hillshades created for cartographic purposes should always have the sun located in the 
northwest. You may have to experiment with the azimuth and angle, especially if the 
surface has valleys and ridges that trend along a northwest-southeast line, in which case 
few shadows are created and the 3D effect is lost. 
 

□ Remove hillshade2 from the map. 
 
 
STEP 2: SHADED RELIEF 
By combining a hillshade with a layer of colored thematic data like vegetation, you can 
create a map of shaded relief. ArcMap creates this effect using the grays in the hillshade 
to set the value (i.e., lightness or darkness) of the colors in the thematic layer on a cell-
by-cell basis. You will now create a shaded relief map using the LandWater and 
Hillshade layers. 



 
 

□ Move hillshade to the bottom of the Table of Contents. 
□ Turn off all layers except Land Water and hillshade. 

 
As you see, the Land Water layer simply shades water blue and land light brown. By 
itself, it is not very impressive, and because it is opaque, you cannot see the hillshade 
underneath it. 
 
 

□ On the Main Menu, click View> Toolbars > 
Effects. 

 
□ From the Effects toolbar, choose Land Water 

from the Layer dropdown list. 
 

□ From the Effects toolbar, click the Adjust 
Transparency tool. 

 
□ Drag the Transparency slider to 50%. 

 
 
The LandWater layer is now 50 percent transparent, and its colors are combined with the 
hillshade beneath it. 
 

□ Turn off all layers and collapse their legends. 
□ Save your map as Ex11a in your ... \Exercise11 folder. 

 
 
STEP 3: USE A MULTIDIRECTIONAL, OBLIQUE-WEIGHTED, SHADED-
RELIEF METHOD 
 
 
The traditional oblique illumination techniques you used in the previous step to simulate 
3D renditions of the terrain can wash out terrain details, especially in terrain faces that are 
illuminated directly or left in the dark by a single-source illumination. 
 

□ Turn on hillshade. 
 
Dr. Robert Mark of the U.S. Geological Survey experimented with the display of raster 
data to enhance its 3D rendition and wrote an algorithm emphasizing oblique illumination 
on all surfaces. 
 
His method combines computer-generated, shaded-relief images illuminated from 225, 
270, 315, and 360 degrees azimuths, each 30 degrees above the horizon. He used weights 
that were calculated for each image on a cell-by-cell basis, as well as a generalized aspect 



map with smoothed 1000-meter cells (a combination of the Block Statistics and Focal 
Statistics ArcToolbox tools for neighborhood generalization processing were used before 
computing the aspect). His technique greatly enhanced details that were obliterated using 
the traditional Hillshading technique. 
 
Now you will use the Customize dialog to load the custom application, use it to apply the 
algorithm described above to your Elevation layer, and you will: 
 
 

□ Click Tools > Customize and click the Commands tab. 
 
The last task ensures that the customization will only be made to your current map 
document, not to the normal ArcMap template. 
 

□ Click Add from file.  
 
□ Navigate to and add ... \SPAG\Software\.AdvancedHillshade.dll. 

 
□ For Categories, click Spatial Analyst.  

 
□ For Save in, select Ex11a.mxd. 

 
□ Drag the AdvancedHillshade and drop it on the end of the Effects toolbar. 

 
□ Click Close to close the Customize dialog. 
 

Now use Dr. Mark’s hillshade algorithm to see what it does. 
 

□ Click the 
Multidirectional, 
oblique-weighted, 
shaded-relief 
button. 

 
□ For Input Surface, 

select Elevation. 
 

□ For Z Factor, 
accept 1 as the 
default. 

 Multidirectional oblique- 
weighted hillshade 

Traditional Hillshade □ Click OK. 
 

□ Save your map as MarkHillshade in your ... \Exercise11 folder. 
 
 



STEP 4: USE THE SWISS-STYLE HILLSHADING TECHNIQUE 
 
In this step, you will use multiple hillshades and layer transparency to create a smoother 
hillshade effect that is useful in cartographic applications. This style of Hillshading is 
often called the “Swiss” method. 
 
First, create a new map and set your environments. 

□ Click New Map File. 
□ Add Elevation.lyr from your ... \Exercise11 folder. 
□ Set these Environment Settings: 

o Current Workspace: ... Exercise11 
o Scratch Workspace: ... \Exercise11 
o Output Coordinate System: Same as Layer “Elevation” 
o Cell Size: Same as Layer ‘Elevation” 
o Mask: <none> 

 
First you create a standard hillshade. It is not used in the final display, but the other 
Hillshades are derived from it. 
 

□ Run .. > Surface > Hillshade: 
o Input raster: select Elevation 
o Output raster: accept the default name 
o Accept the defaults for the remaining parameters 

□ Rename the new layer to StandardHillshade 
 

Then you smooth the standard hillshade with the Focal Statistics tool.  
 

□ Run .. > Neighborhood> Focal Statistics: 
□ Input raster: select StandardHillshade 
□ Output raster: accept the default name 
□ Neighborhood: select Circle. 
□ Radius: type 4 
□ Statistics type: select MEDIAN. 
□ Rename the new layer to FocalMedianHillshade 

 
Finally, you weight the standard hillshade with the elevations using Map Algebra. 
 

□ Run Single Output Map Algebra: 
□ Map Algebra expression: type 

 
Elevation / 5 + Standardhillshade 

 
□ Output raster: accept the default name. 
□ Rename the new layer to SwissHillshade 
 

Here are the hillshades you have created: 
 



 
 
 
 
 
 
 
 
 
 
 
 Focal median hillshade Swiss hillshade 
 
Traditional Hillshade 

Hillshades using black to white monochromatic color ramp 
 
 
The StandardHillshade is not used for the final graphic. You can turn it off.  

 
□ Turn off StandardHillshade and collapse its legend. 
 

Now you are ready to combine the hillshades graphically and draw a thematic layer on 
top of them. You will set the transparency and symbology for the hillshades. You will use 
your symbolized Elevation layer for the thematic layer. But first, the display order is 
important, so you will now organize your Table of Contents. 
 
 
In the Table of Contents, move the layers so they appear in this order: 

• Elevation 
• FocalMedianHillshade 
• SwissHillshade 

 
These layers should all be on. Now set the symbology and transparency for the layers. 
 

□ For Elevation, open the Layer Properties and set these settings: 
 
o On the Display tab, set Transparent to 55%. 

 
o On the Symbology tab, select the Stretched renderer and set the Color 

ramp to Elevation #1. 
 
□ Close the Layer Properties for Elevation. 

 
□ For FocalMedianHillshade, open the Layer Properties and make these settings: 

 
o On the Display tab, set Transparent to 35%. 

 



o On the Symbology tab, select the Stretched renderer and set the Color 
ramp to Black to White. 

 
□ Close the Layer Properties for 

FocalMedianHillshade. 
 
□ For SwissHillshade, open the Layer Properties and 

set these settings: 
 

o On the Symbology tab, select the Stretched 
renderer and set the Color Ramp to Black to 
White. 

 
□ Close the Layer Properties for SwissHillshade. 

 
 
The final effect is a softer surface that does not interfere with the thematic layer. 
 

□ Save your map as Swissflillshade in your Exercise11 folder. 
 
 

STEP 5: USE HILLSHADES ANALYTICALLY 
 
Hillshades have analytic uses as well as cartographic uses. The grayscale values it returns 
(0 to 255) may also be interpreted as an index of sun exposure, where cells that have little 
sun exposure have low values (0) and those that are fully illuminated have high values 
(255). You can use the exposure values to model agricultural suitability, classify 
vegetation, and so on. 
 
Using hillshades analytically requires that you place the ‘sun’ in its true position for a day 
and time of year. This varies according to geographic location—that is, at 12:00 noon on 
a given day of the year, the sun has a different azimuth and altitude in Seattle, 
Washington than it does in Dallas, Texas. 
 
Computing the position of the sun for a given time and location involves advanced math. 
Fortunately, the United States Naval Observatory Web site computes it for you when you 
enter the location, date, and time: 
 
http://aa.usno.navy.mil/data/docs/AltAz.html 
 
In the following scenario, you are trying to find the best places for a ski resort in the Lake 
Tahoe area. As part the model, you want to identify slopes that are shaded during the 
snow months. You will compute a hillshade for the middle of each month, placing the 
sun in its correct location, and then average the sun exposure for the six months. The 
Naval Observatory Web site has given you the azimuth and altitude settings: 
 



November 2003:  Az = 166.6  Alt 37.2 
December 2003:  Az = 183.1  Alt 32.8 
January 2004:   Az = 179.3  Alt 35.2 
February 2004:  Az = 177.6  Alt 43.7 
March 2004:   Az 179.2  Alt 54.3 
April 2004:   Az = 184.3  Alt 66.1 
 
You will only calculate the hillshade for April; the others will be provided. 

□ Open a New Map File. 
□ Add Elevation.lyr from your ... \Exercise11 folder. 
□ Set these Environment Settings: 

o Current Workspace: .. \Exercise11 
o Scratch Workspace: ... Exercise11 
o Output Coordinate System: Same as Layer “Elevation” 
o Cell Size: Same as Layer “Elevation” 
o Mask: <none> 

 
□ Run ... > Surface > Hillshade: 

o Input raster: select Elevation 
o Output raster: type April 
o Azimuth: type 184.3 
o Altitude: type 66.1 

 
 
The April hillshade looks inverted because the sun was positioned in the south, casting 
shadows at the top of the mountains. Now you add the precomputed hillshade layers for 
November to March. 
 

□ Turn off April and close its legend. 
 
□ Add the following layers to the map from your ..\Exercise11 folder: 

o November lyr 
o December.lyr 
o January lyr 
o February lyr 
o March.lyr 
 

The new layers are turned off and their legends are closed. If you want to, you may 
organize the new layers by date and turn them on in order, bottom to top, to see how the 
illumination changes over time. To finish this step, you will use the MEAN function to 
compute the mean illumination for each cell based on the six input months. 
 

□ Turn off all layers and close their legends. 
□ Run ... > Local> Cell Statistics: 
 



Input rasters or constant values: Select all the month layers in the ArcMap Table of 
Contents and then drag and drop them into this field. 
 

□ Output raster: Accept the default name 
□ Overlay statistics: select MEAN 

 
You are actually writing the following Map Algebra statement: 
MEAN (November, December, January, February, March, April) 
 

□ Rename the new layer SunExposure 
□ For SunExposure, change the renderer to Stretch with the Minimum-Maximum 

type and the Black to White color ramp. 
 
The new SunExposure layer shows the average sun exposure over a 6-month period. In 
your ski resort model, you would give higher weighting to slopes with lower sun 
exposure than those with high sun exposure. Now you will use a Map Algebra expression 
to create a raster of the cells with average exposure values less than 100. 
 

□ Run ... > Math > Logical> Less Than: 
o Input raster or constant value 1: select 

SunExposure Sun exposure 
o Input raster or constant value 2: type 100 
o Output raster: accept the default 

 
 

GoodSun 
You are actually writing the following Map Algebra 
statement:  SunExposure LE 100 
 

□ Rename the new layer Goodsun 
□ Set the symbol colors. Use any purple for Value 1 

and No Color for Value 0. 
 
Now you will make a nice map by adding the LandWater layer and a standard hillshade 
to enhance the visualization of your Sun Exposure data. 
 

□ Turn off SunExposure. 
 
□ Add LandWater.lyr from your ... \Exercise11, give it 50% transparency, and 

place it at the bottom of the Table of Contents. 
 
□ Create a standard hillshade from the Elevation layer, name it Hillshade, and place 

it at the bottom of the Table of Contents. 
 
Based only on sun exposure, the ski runs. purple areas (GoodSun) on the map are the best 
for ski runs. 
 



□ Turn off all layers and close their legends, except for Hillshade and Land Water. 
 

STEP 6: CREATE A CONTOUR LAYER 
Contours are lines that connect points of equal elevation or, more generally, points of 
equal Z, where z-values may be things like rainfall, air pollution, or noise. Contours are 
best used in maps as indicators of underlying topography; very little analysis may be 
performed with them. In this step, you will create contours from Elevation. 
 

□ Run ... > Surface> Contour: 
o Input raster: select Elevation 
o Output raster: accept the default 
o Contour interval: type 100 
 

□ Rename the new layer to Contours 
 
□ Change the line symbol color to a dark brown. 
 

The contours were created as lines in a shapefile. You 
can label the contours with their z-values (stored in the 
CONTOUR field of the shapefile’s attribute table) using 
the Label tab of the Layers Properties dialog, but you will 
not. 
 
The Contour tool on the Spatial Analyst toolbar is a data exploration tool. Set the layer to 
the surface of interest, click on the tool, and then click somewhere on the surface. One 
contour will be created as a graphic. 
 

□ Save GoodSun as a layer called GoodSun.lyr in your ... \Exercise11 folder. (You 
will need it again later.) 

□ Save your map as AnalyticalHillshade.mxd in your ... \Exercise11 folder. 
 
 
STEP 7: USE SLOPE, ASPECT, AND CURVATURE 
Slope and aspect are both measures of the shape, or morphology, of a surface. Slope is 
the change in Z over distance (or steepness) through a cell and aspect is the direction of 
the steepest path through the cell relative to north (or the orientation of the cell). Both are 
properties of the surface gradient, so the SLOPE and ASPECT functions are the same 
algorithm (one that computes gradient); they just return different properties. 
 
Slope is typically applied to topography but may be uselbl in analyzing other types of 
surfaces. For example, when applied to a surface of rainfall, slope reveals areas, where 
rainfall is changing, and also reveals the speed of that change (e.g., steeper “slopes” are 
changing faster). 
 



Slope may be expressed as degrees (e.g., 45 degrees) or as a percentage (e.g., 50%). 
Degrees are commonly used in scientific applications, while percentages are commonly 
used in transportation studies (e.g., “Caution: 6% grade ahead!”). 
 
Start by deriving slope from the Lake Tahoe elevation surface. You will find appropriate 
slopes for a ski run. 
 

□ Open a New Map File. 
□ Add the Elevation.lyr layer from your ... Exercise11 folder. 
□ Set these Environment settings: 

o Current Workspace: ... \Exercise11 
o Scratch Workspace: .. \Exercise11 
o Output Coordinate System: Same as Layer “Elevation” 
o Cell Size: Same as Layer “Elevation” 
o Mask: <none> 
 

□ Run ... > Surface > Slope: 
o Input raster: select Elevation 
o Output raster: accept the default name 
o Output measurement: select PERCENT_RISE 
o Rename the new layer slpPercent 
 

The Slope tool automatically applies the Slope color ramp to its output layer. The red 
areas have steep slopes, and the green have flatter slopes. The values range from zero to 
about 178. Percent slope is computed as rise over run times 100, so if there is a lot of rise 
over a very short run, the values can approach infinity. 
 
Now use the Slope tool to compute slope in degrees. 
 

• Run ... > Surface > Slope: 
o Input raster: select Elevation 
o Output raster: accept the default name 
o Output measurement: select DEGREE 

• Rename the new raster layer SlpDegree 
 

The SlpDegree layer has the same green-to-red color ramp as SlpPercent. Notice that 
in the legend for SlpDegree the values range from 0 to about 61 degrees. The highest 
possible slope is 90 degrees—a vertical cliff. 
 
For your ski resort, assume that the best ski runs are those with slopes ranging from 
15 to 45 degrees. Less than 15 degrees is too flat, while those over 45 degrees have 
too much avalanche risk. Now you will use a Map Algebra expression to create a 
raster of cells with the best slopes. 
 

o Run Single Output Map Algebra: 
o Map Algebra expression: type  



SlpDegree GE 15 AND SlpDegree LE 45 
 
 Output raster: accept the default name. 

 
o Rename the new layer GoodSlope 

 
o Set the symbol colors. Use any orange for Value 1 and No Color for Value 0. 
o Turn off SlpDegree and SlpPercent and close their legends. 

 
o Add LandWater.lyr and give it 50% transparency, and place it below 

GoodSlope in the Table of Contents. 
 

o Create a standard hillshade from the Elevation layer, name it Hillshade, and 
place it Land Water in the Table of Contents. 

 
 

Based only on slope, the orange areas on the map are the best for ski runs. Now 
combine the GoodSlope and GoodSun layers to find places, where both the slopes 
and sun exposures are good for ski runs. 
 

o Turn off GoodSlope and close its legend. 
o Add the GoodSun.lyr file to map from \Exercise11 folder. 

 
□ Run > Math > Logical> Boolean And: 

o Input raster or constant value 1: select GoodSlope 
o Input raster or constant value 2: select GoodSun 
o Output raster: accept the default name 

 
NOTE: You are actually using the following Map Algebra expression: 
Goodslope AND GoodSun 
 

□ Rename the new layer Skirun 
 
□ Set the symbol colors. Use any yellow for Value 2 and No Color for Value 0. 
 

The yellow areas have slopes and sun exposures suitable to ski runs. 
 

□ Turn off all layers and close their legends. 
 

You could have used aspect in the ski model by assuming that north-facing slopes are 
more shaded than south-facing slopes. But the hillshade provided a more reliable measure 
of sun exposure, so you used it instead. Regardless, aspect is useful in many terrain 
analysis applications. Now you will compute aspect using the Aspect tool. 
 

□ Run ... > Surface > Aspect: 
o Input raster: select Elevation 
o Output raster: accept the default name 



o Rename the new layer Aspect 
 

Aspect returns compass directions as decimal degrees, where 0 and 360 are both due 
north. Perfectly flat areas are assigned a code of -1. Again, the dialog used appropriate 
symbology and created useful legend text to help you interpret the symbols. 
 

□ Turn off Aspect and close its legend. 
 

Using Aspect in some types of analysis is a challenge because of the nature of the 
angular measurement; an aspect of 359 degrees is very close to an aspect of I degree 
(they are only three degrees apart), but mathematically they are 358 degrees apart. 
Since these are angles, you can use the trigonometry functions to convert aspect degrees 
into ‘percent of north-facing’. The COS (cosine) function returns values between I (due 
north) and -1 (due south). You can add I to the cosine to get values of 0 to 2, then divide 
by 2, and multiply by 100 to create a raster of ‘percent of north’. The Map Algebra 
expression would look like this: 
 
(COS(Aspect / DEG) + 1) / 2 * 100 
 
You may be curious about the Aspect / DEG part of the expression. The trigonometry 
functions work against angles measured in radians, not degrees. DEG is a built-in 
variable that stores the constant needed to convert degrees to radians. 
 

□ Save your map as SlopeAspect in your – \Exercise11 folder. 
 
 

STEP 8: USE VIEWSHED ANALYSIS 
Viewshed analysis examines every cell to determine if it has a clear line of sight to one or 
more observation points, based on whether there are high intervening cells that block the 
straight line between the cell and the observer. It returns a simple count of the number of 
observers that can see the cell. There are many potential applications for viewshed 
analysis in GIS, like hiding unsightly oil storage tank farms, determining lines of fire for 
a fortification, or siting cellular phone antennas. 
 
In this scenario, the National Park Service has problems with radio communications 
between their various facilities, and they need to build a repeater tower. The tower site 
must be able to ‘see’ all of their facilities. 
 

□ Open the Ex11a.mxd map that you saved earlier. 
 
□ Add the following layers to the map from your ... Exercise11 folder: 

o ParkEacilitieslyr: The observation points for analysis 
o TopoMap.lyr: A scanned topographic map for background 
o LandMask.Ivr: A mask; land has a value and Lake Tahoe is NoData 
o Put ParkFacilities at the top of the Table of Contents, if necessary. 
o Turn on ParkFacilities, TopoMap, and Hillshade. 



 
□ Open the ParkFacilities legend. 
 

Each facility has a radio mast. The headquarters mast is 100-feet tall, and all the others 
are 50 feet tall. The repeater tower will be 100-feet tall. 
 
The Viewshed tool is easy to use and has few parameters to set. That is because most of 
the parameters are carried as attributes of the input observers, which may be points or 
lines in a coverage, shapefile, or a geodatabase feature class. All the parameter fields are 
optional (they have defaults) and if used, must store either integer or decimal numbers, 
but their names are special and must be as shown below. 
 
• SPOT: Specifies an absolute elevation for the observer. The default is the elevation 
found at the point. Use SPOT only when the observer (usually a line) has a constant 
elevation, like the planned flight path of a plane on a photo reconnaissance mission. 
The next two attributes modify the surface elevations based on the height of the observer 
and the height of the structure you are trying to see. 
 
• OFFSETA: Specifies a z-value to be added to the elevation at the observation point. In 
this step, this is the height of the radio mast at the various park facilities. The default is 1. 
 
• OFFSETB: Specifies a z-value to be added to a nonobserver cell when it is being 
analyzed for visibility. In this step, this is the height of the 
proposed repeater tower (100 feet). The default is 0. 
 
The remaining attributes limit the analysis to a volume of 3D space. If you let them all 
default, the whole input raster is analyzed for visibility, which can be very slow for large 
rasters. 
 
• AZIMUTH1 and AZIMUTH2: Specify the beginning and ending horizontal angles to 
limit the analysis, which proceeds clockwise from AZIMUTH] to AZIMUTII2. Values 
are specified in degrees from 0 to 360. The defaults are 0 and 360 (the whole input 
raster). 
• VERT1 and VERT2: Specify the angles above and below the horizon (respectively) to 
limit the analysis. Positive angles are above the horizon; negative values are below it. The 
defaults are 90 for VERT1 and -90 for VERT2. 
 
• RADIUS1 and RADIUS2: Specify the inner and outer radius to limit the analysis. Only 
cells farther than RADIUS1 and closer than RADIUS2 are considered. The defaults are 0 
to infinity. 
 
Your ParkFacilities layer only has OFFSETA and OFFSETB attributes. OFFSETA is the 
height of each facilities radio mast, and OFFSETB is 100 feet (the height of the proposed 
repeater tower) for every point. Now run the viewshed analysis.  You do not need to reset 
the analysis environment parameters as those were set and saved in the Ex08a.mxd. 
 



o Run ... > Surface> Viewshed: 
o Input raster: select Elevation 
o Input point or polyline observer features: select ParkFacilities 
o Accept the default name and location for the Output raster 
o Rename the new layer Viewshed 

 
The legend for the Viewshed layer is a bit misleading. It has classified all the cells into 
either visible (green) or non-visible (pink) from any observer. This is an artifact of the 
symbology the dialog assigned. In fact, the actual value of a cell is a count of the number 
of observers that can ‘see’ it. Now you will change the symbology to reflect the values. 
 

□ Open the Layer Properties dialog for Viewshed. 
□ On the Symbology tab, choose Show Unique Values. 
□ Click Add All Values and symbolize using the subtle pastel colors. 
□ Click OK. 

 
You have noticed that cells in Lake Tahoe have values for visibility. These are not very 
attractive, so your next step is to turn them into NoData with a processing mask. This step 
is necessary because Viewshed ignores masks in its analysis; so even if you had 
previously set the mask in your analysis environment, Lake Tahoe cells would still have 
been analyzed. 
 

□ Right-click in the ArcToolbox panel and click Environments. 
□ Expand Raster Analysis Settings and change the Mask to LandMask. 
□ Run Single Output Map Algebra to calculate a new raster using the following 

Map Algebra expression: Viewshed 
□ Rename the new layer Towersites 

 
Finally, assign better colors to the Tower site symbols and make the final map. 
 

□ Right-click on the symbol for value 0 and choose No Color. 
□ Value 1: select a light green (Tzavorite Green; 1st row, 7th column). 
□ Value 2: select a medium green (Sage Dust; 7th row 7th column). 
□ Value 3: select a dark green (Tarragon Green; 5th row, 6th column). 
□ Value 4: select a bright red (Mars Red; 3rd row 2nd column). 

 
□ Set the TowerSites transparency to 50%. 
□ Turn off all layers except TowerSites, ParkFacilities, TopoMap, and Hillshade. 

 
The bright red cells are those that are visible from all four park facilities. The new relay 
tower could be located in any of these locations. 
 

□ Exit ArcMap without saving changes. 
 

EXERCISE END 


